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ABOUT THIS GUIDE

About this guide

This guide contains the procedures and information you need to configure network templates in
MetaSolv Solution.

Audience

This guide is for individuals responsible for the configuration and maintenance of network templates
in MetaSolv Solution.

Additional information and help

To get additional information or help for MetaSolv Solution, refer to the following resources:

® Oracle E-Delivery—Provides access to product software and documentation.

O

O

Visit the E-Delivery Web site at http://edelivery.oracle.com.

Software and product documentation are contained in the Oracle Communications MetaSolv
Solution 6.0 Media Pack.

Developer documentation is contained in the Oracle Communications MetaSolv Solution
Developer Documentation Pack. Access to developer documentation requires a password.

e Oracle MetaLink—Provides access to software patches and a searchable Knowledge Base.

@)

Visit the MetaLink Web site at https://metalink.oracle.com/, and log on using your User Name
and Password.

Click the Patches & Updates tab to search for patches (efixes).
Click the Knowledge tab to search for technical bulletins, fixed issues, and additional product

information. To narrow your search, click the Communication Apps link under Product
Categories on the left side of the page.

Oracle Support

The preferred method of reporting service requests (SRs) is through MetaLink. MetaLink is available
24 hours a day, 7 days a week.

Although it is Oracle’s preference that you use MetaLink to log SRs electronically, you can also
contact Support by telephone. If you choose to contact Support by phone, a support engineer will
gather all the information regarding your technical issue into a new SR. After the SR is assigned to a
technical engineer, that person will contact you.

©MetaSolv Software, Inc.
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For urgent, Severity 1 technical issues, you can either use MetaLink or you can call Support. Oracle
Support can be reached locally in each country. To find the contact information for your country, go to
http://www.oracle.com/support/contact.html.
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NETWORK TEMPLATE OVERVIEW

Network template overview

Network templates play a vital role within MetaSolv Solution. They are part of what is commonly
referred to as the “template-based platform.” This platform was created to simplify the design of
networks, the ordering of products, and the provisioning of services within MetaSolv Solution.
Network templates serve as a guideline or a blueprint, containing predefined rules that specify how to
design networks, order products, and provision services.

Template-based network design provides a flexible platform that helps you design and configure any
type of network, from simple to complex. It is based on the concept that technologies, products, and
services are rapidly changing. By creating a design platform that can grow and change along with
your business, MetaSolv can ensure that your Operations Support System will continue to meet your
network design and management requirements. In addition, by providing a common platform that you
can use regardless of the technology, you can create repeatable, transferable business processes that
ultimately help you configure new products and services more easily, and design and deliver them
more consistently.

©MetaSolv Software, Inc. 3



NETWORK TEMPLATE OVERVIEW

Downstream effects

How you configure your network templates affects three major processes in MetaSolv Solution:
¢ Network design

¢ Ordering

¢ Provisioning

The rules defined in the network templates govern the design of internal and external networks, the
specifications of products and services that you use to build the product catalog for customer orders,
and the provisioning of those products and services. Network design involves creating internal
networks, while service provisioning can involve creating customer networks and connections.

Network design

The component and connection relationships you use to design a network inherit the properties you
defined for those component and connection relationships in the template.

For example, assume in the MetaSolv TM Frame Relay Core Network template, you customize a
bandwidth connection between two frame switches to have a transmission rate of OC-3. If you later
use that template to design a network, you will only be able to design bandwidth connections with a
rate code of OC-3 between frame relay switches.

You can also select which components can be ordered, and determine if equipment from multiple
locations can be associated with a component. When you design a network using a template, you
don’t need to redefine properties each time you add a component or connection to a system, and you
cannot break any rules that underlie how your networks are to be designed.

Ordering

Network templates determine which network systems, components, and connections you can order on
a Product Service Request (PSR) in MetaSolv Solution. When you build product offerings, you
associate them with network templates, and those templates drive what you can order.

For example, assume an order has been placed for a virtual private network (VPN), and you are the
ordering specialist. You select the VPN product from the product catalog. The template previously
associated with the product determines the types of components and connections you can add to the
PSR from that point forward. As you add items to the PSR, the properties defined for those items in
the template may prompt you for additional information.

©MetaSolv Software, Inc. 4



NETWORK TEMPLATE OVERVIEW

Provisioning

The rules, properties, and custom attributes of a template associated with an ordered item (system,
component, or connection) control how you provision that item.

For example, assume you are the engineer of the VPN that was ordered in the preceding example.
When you execute the NETDSGN task from your work queue, you see the network canvas. As you
design each connection for the ordered VPN, the assignments you make will be driven by and will
depend on the connection specs and equipment associated with the component types to which you are
making the assignment.

Helpful terms

To understand the functionality behind network templates, you must first understand the terms used in
MetaSolv Solution. Some of these terms are well known in the communications industry, and some
are unique to MetaSolv.

The easiest way to understand network template terminology is to examine it in hierarchical form,
from the top level down. The top level in network templates is the Technology Module.

Technology modules

Technology modules are software options that map to technology types. Technology modules were
developed for the most common technology types used by service providers. As an owner of
MetaSolv Solution, you need only those technology modules that comprise the technologies of your
networks.

Technology
Module

©MetaSolv Software, Inc. 5



NETWORK TEMPLATE OVERVIEW

At the present time, you can license the following technology modules:

ATM/Frame Relay—Used for ATM/Frame Relay transport networks and Layer 2 VPN networks.
DLC—Used for DLC transport networks.

DSL—Used for DSL transport networks.

Ethernet—Used for Ethernet transport networks.

[P—Used for IP transport and IP VPN networks.

MPLS—Used for MPLS transport and MPLS VPN networks.

Optical/TDM—Used for Optical/TDM networks.

SONET/SDH—Used for SONET/SDH networks.

Wireless—Used for wireless networks.

Unclassified—Used for templates that do not fit into other technology types.

When you license a specific technology, you receive a technology module that includes predefined
templates and documentation about the contents of those templates.

Network templates

Technology
Module

Template

Think of a template as a blueprint or stencil. Each template contains the rules and building blocks
needed to design your network systems, order products, and accurately provision services. MetaSolv
examined the components and connections most commonly used by providers, and built the templates
accordingly. Network templates include components, connections, graphics, and rules for a specific
technology. If you do not have the technology module or network system type, you will not be able to
create templates based on that particular technology. You might not need all of the components or
connections provided by the delivered templates, or you might find that you need something that is
not delivered. To accommodate these situations, you modify the network templates. For more
information, refer to “Modifying existing templates” in Chapter 4.

©MetaSolv Software, Inc. 6



NETWORK TEMPLATE OVERVIEW

A technology module can have multiple templates. Most of the technology modules include core and
access network templates. For example, the ATM/FR technology module includes six templates:

e The ATM Core Network and Frame Relay Core Network templates are used to build provider
networks.

e The ATM Access Network and Frame Relay Access Network templates are generally used to
build networks that connect the customer to the provider network.

e The ATM/Frame Relay Network template is used to create a large network that includes both
access and core networks.

e The Layer 2 VPN Network template is used to build customer-ordered virtual private networks.

Templates provide a graphical view that you can customize to reflect the components and types of

connections that make up your network systems. Below is the ATM Access Network template, as
delivered with the ATM/FR technology module.

lel EE R o =

IP Hetwagrk

panugy
a

EAIm.=
Custamer Ene

whine Gatesay
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NETWORK TEMPLATE OVERVIEW

Component types

Technology modules provide sets of templates that contain the most common combinations and
configurations of component types, relationships, and connection specs. The first of these is the
component type.

Technology
Module

Template

Component Type

Component types are representations of nodes that can exist in a network system. Component types
are represented on the graphical canvas by images or graphics. Some examples of component types
include:

= i:: H .-
Back —
= Customer Site

Fggregator Sﬁmh Bane Ranter
it

The delivered network templates contain preloaded component types with preloaded images. You can
add new component types and customize existing component types.

Each component type is represented only once in a template, establishing it as a possible component
when designing your network system. For example, if your network has three ATM switches, the
ATM Switch component type must exist in the template for you to build ATM switches in your
network. If the component type is not part of the template used to build the network, it will not be
available to add to the network design. Because you have three ATM switches, you will reuse the
ATM Switch component type in the template three times during network design.

The following figure shows the relationship between component types in a template and components
in a network system built using that template.

©MetaSolv Software, Inc. 8
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Network Design

Template

Sample ATM Switch 2

T
Component Type

Sample ATM Switch 1

Sample ATM Switch 3

EMBEDDED NETWORKS

Embedded networks are component types that represent smaller groupings of network components
within a larger network. They are represented as clouds in a template because they exist as a separate
network template. Remember that component types are only represented once in a template, which is
also true for embedded network component types. Embedded network component types represent the
networks that are created with other templates.

For example, the ATM Access Network template contains an IP Network component type. When
building a network using the ATM Access Network template, you are able to connect your SMS and
ATM Switch component types to a component type in an IP network you created using a different
template. The IP network exists separately, but is part of this larger ATM network, as shown in the
following figure.

©MetaSolv Software, Inc. 9
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= BE Q& =
Iriter m— 5
—
sruis
Irter Intra ritra
Embedded Network
Intra m
Irter AT Switch
Iritra P5STH Intra Initra
Irter \ Irter
Irtra /
—
= Intra
 e— i
Aggregatar
Whice Gateway
Tip

To view the component types within an embedded network on the graphical canvas, double-
click the embedded network. You can also view the component types by expanding the
Component Types treeview on the Network Template Detail panel list.

Iy Deskbop | Find Uinks | Shows Mavbar Network Template - MetaSolvy TM ATM Access Network

i Edt » Wiew w Options»  Window -

Comgonent Types
Conneclion Specs
Metwork Terglate Detal
[=l MetaSohe Th ATH Access Metwork

File »
A

| Metwork Templales
B

c’ Other Provider Netwark
*

=1 Component Types -aj
=P Mebwork \‘\-h___;-" wr
| =k Comporent Types : IF Hetiork
i IF Othes Provider el w-----=-=--=--moommmees e
P Fiaube:
[#- Aelshiorships
+ PSTN Inter
- Aggregator
- T Switeh Iiria
-~ Cushames Site
e rtra Fier
- Woice G ateway T
i Relabonships — S Irira
T
A Qregater
ioe Gatemay
10
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NETWORK TEMPLATE OVERVIEW

In the example above, the embedded IP Network is comprised of IP Router and IP Other Provider
Network component types. The IP Network also exists as a separate network template, as seen below.

Network Template - MetaSoly TM IP Network

File » Edit+ View - Options -  Window

o =
[=iae |
Network Templates Inra
Component Types
= -
== Connecton Specs Intra
Metwark. Ternplate Detall
IR Oth
51 MetaSoly TM IP Network * Roter Provider
=] l:ljl'l'lpl:lr'u?r'll l!,'l:lE"E' Netunark:
|P Other Provider Hetwark
|P* Fouter
- Relationships
Tip

If you expand an embedded network component type and then save and close the template, it
will be expanded the next time the template is viewed. This is not contingent on your user 1D,
but will be the view of any user who opens the template as it is saved.

Other Provider Network component types

The one embedded network component type that you cannot open and view is the Other Provider
Network component type. This component type represents another provider’s network that you do not
inventory in the application, and is represented by a striped cloud as seen in the previous example.

©MetaSolv Software, Inc. 11



NETWORK TEMPLATE OVERVIEW

Relationships

Technology
Module

Template

Component Type

Relationship

Relationships in network templates represent a future connection that may exist between two
component types. Relationships are shown on the graphical canvas as a solid line between component
types. There can be multiple relationships in a template, but only one relationship can exist between
two component types. Similar to component types, relationships exist only once in a template.

Following is an example of relationships in a template. In this template, two relationships exist. The
first is between the IP Router component type and the IP Other Provider Network. This means that
when you use this template to build a network system, you can build a connection between any IP

router and other provider IP network.

Metwork, Templates
Compaonent Types

Connechion Specs

Metwork, Template Detal

= MetaSoly TH 1P Metwiork
-- Component Types
- Relationzhips
28 P Fouter - Intranetwarking - [P Other Provider Network
- IP Router - [ntranetwaorking - 1P Bouter

Intranetworking means a
relationship can exist
between component types in
the same network.

Intra

IP Other
Provvider
MNetwark

IP Router

©MetaSolv Software, Inc.
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NETWORK TEMPLATE OVERVIEW

The second relationship is between the IP Router component type and itself.

Metwork. Templates

Companent Types

Connection Specs

Metwork. Template Detail
[=]- MetaSalv TH [P Metwark.

-- Component Types intr=

= Relationzhips
&l IP Router - Intranetwarking - 1P Other Provider Metwark IF Router :,T_DE:E::
58 (P Flouter - Intranebworking - [P Fouter Hetwark

This means that when you use this template to build a network system, you can build a connection
between any two IP Routers. The following figure illustrates the IP Router — Intranetworking — IP
Router relationship as built out in a three-node IP network.

IP Fouter -3

Network Design

Template

IF Router - Intranetworking - [P Raouter - Irtranetworking -
IP Router IP Router

IP Router

IP Raouter - Intranetworking -
IP Router

IP Fouter - 1

IP Router - 2

As with component types, if a relationship does not exist in a template, it is not available when
building network systems using that template.

©MetaSolv Software, Inc. 13
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Connection specs

Technology
Module

Template

Component Type

Relationship

Connection Spec

A relationship signifies some type of connection can exist between two component types. To identify
the type of connection it is, you use connection specs. As noted earlier, there is a relationship between

the IP Router and IP Other Provider Network component types in the IP Network template.

Metwork, Templates

Component Types

Connection Specs

Metwork Template Detal

=~ h-'!etaSu:ulv T 1P Metworl
[+~ Compaonent Types
E=- Relationships

-- IF Router - [ntranetworking - 1P Other Provider M etwark:,
[+ IP Router - Intranetworking - IP Router

Relationship

Intra

IP Router

IP Cther
Prowider
Metwoark

©MetaSolv Software, Inc.
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NETWORK TEMPLATE OVERVIEW

The different types of connections that can be used to build this relationship in an IP network are the
connection specs specified in the template, as shown below.

Metwark. Template Detail I

[=- MetaSoly TH 1P Metwork

-- Comporent Types

- Felationzhips
2B IP Fouter - Intranetworking - IP Other Providsr N etk
E i Azzignable Bandwidth Link
- Unassignable Bandwidth Link [2.0. D51/E1)
: L |rwerse kMultiplexing Group [e.q. 4.56, BM. 7.5M]
- IP Router - [ntranetwaorking - 1P Bouter

If a connection spec is not in the template, it is not available for you to use when you build your
network. Each delivered template contains preloaded connection specs. You can create new

Connection
Specs

connection specs and modify existing connection specs, if needed.

©MetaSolv Software, Inc.
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NAVIGATING TEMPLATES

Navigating templates

This chapter walks you through the template interface, so you have a feel for the basic navigation
prior to creating or modifying templates.

Opening templates

1.

2.

3.

4.

Select the Inventory Management group on the navigation bar, and click Inventory
Management Setup.

Under Network/Equipment, click the Network Templates link.
Double-click the technology module that contains the appropriate template.

Double-click the template name to open it.

The Network Templates window appears. Two primary sections comprise the window—the panel
lists and graphical canvas. These sections are shown in the following graphic.

©MetaSolv Software, Inc. 17
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Menu
icon

Fie » Edite VYiews Options» ‘Window Help» X
4 = @i =
> Network Templates
Component Types
Cannection Specs =,
= Initer
Metwork Template Detall %
ShS
Bl I‘v‘!etaSoIv TH ATM Access Netwark P Rt |I
[+ Component Types
B o 2 Inter Irtra
[+ Relationshipz
Intra
Inter
‘ ATM Suiteh
Iritra [ Iritra
FaTi
Initer Initer
Intra
e
=
e
Agaregator
“whice Gateway

Panel Lists

Graphical Canvas

Graphical canvas

The graphical canvas displays graphical representations of the templates. When you open a template,
this area of the window provides a view of each component type, as well as relationships between the

component types. The previous figure shows the graphical canvas as viewed when you open the

MetaSolv TM ATM Access Network template.

Panel lists

On the left side of the Network Templates window are four panel lists—Network Templates,
Component Types, Connection Specs, and Network Template Detail.

On the far left side of the top three panel lists is the menu E& icon. Clicking this icon provides a
selection of options and tasks you can perform. These menu selections differ for each panel list.

Tip

The menu icon is easily forgotten and contains links to network template functionality. If you

are using network templates and are not able to locate the functionality you need, try clicking
the menu icon.

©MetaSolv Software, Inc.
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NAVIGATING TEMPLATES

Tip

The view of the panel lists does not reset to a default each time you log on to the application.
Instead, the panel lists appear as they were when you last logged out.

NETWORK TEMPLATES PANEL LIST

The Network Templates panel list contains all of the technology modules and corresponding

templates that you licensed. When you open this panel list, the technology modules appear. If you
don’t have a license for a particular technology module, it is not listed.

To view the templates contained in each technology module, click the plus sign (“+7) to the left of the
technology module name.

Metwork Templates I
- ATM_FR
&-DLC
- DSL

Technology module |

- MetaSolv TM Ethemet Core Metwork
-~ MetaSolv TM Ethemet Distribution Ne
- MetaSolv TM Ethemet Networl:
i MetaSoly TM WLAMN Metwork

IP
- MPLS
- OPTICAL/TDM
- SOMET/SDH [Ringz, Point-to-Paint, etc...
- UMNCLASS

Templates

+

Click the menu icon on the Network Templates panel to view other options for using the panel list.
Add Template... menu option

Select Add Template to create a new template for a technology module.

©MetaSolv Software, Inc. 19



NAVIGATING TEMPLATES

Search menu option

Select Search to search for a specific template on the Network Templates panel list. When you click
Search, the view of the panel list changes. Enter any part of a network template name as search
criteria in the Template Name field, and click the Search button.

&dd Template. ..

= Metwaork, Templates

v Hierarchy Template Mame

Search | Advanced Search

T emplate Mame

Refresh

To narrow your search using the template type and status, click the Advanced Search link.

= Metwork Templates I

Template M ame

Search | Advanced Search
Template M ame

Template Mame |

Metwork. Templates

Template Type
| Mane] |
[V Active

Search | Basic Search

Template Mame
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NAVIGATING TEMPLATES

COMPONENT TYPES PANEL LIST

The Component Types panel list contains all of the component types contained in a network template.
When you open this panel list, the images and labels for each component type appears.

= Comporent Types

2 @

Central
Back Ot
Suitch Bone =8
Terminal
I
Customer Customer
Edge Site
Raouter
=g
— Digital
Digital Subscriber
Cross-connect Line
Systemn Fress
hultiplexer

Click the menu icon on the Component Types panel to view other options for using the panel list.
Add Component Type... menu option

Select Add Component Type to create a new component type for the template.

Text Only menu option

Select Text Only to view component type labels, without the images.

add Camponent Tvpe. ..

v Images and Text = Component Types
Search Test
ATH Switch
Refresh
SIEs Back Bone

Customer Edge Raouter

Central Office Terminal

Custorner Site

Drigital Crogz-connect Syztem

Digital Subzcrber Line Access Muliplese
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Search menu option

Select Search to search for a specific component type on the Component Types panel list. When you
click Search, the view of the panel list changes. Enter any part of a component type as search criteria
in the Element Name field, and click the Search button.

Tip
Don’t be confused by the Element Name field label. Enter the name of the component type in
this field.

To narrow your search using the component type status, click the Advanced Search link.

CONNECTION SPECS PANEL LIST
The Connection Specs panel list contains all of the connection types and connection specs contained
in a network template. When you open this panel list, the connection types appear.

To view the connection specs for each connection type, click the plus sign (“+7) to the left of the
connection type.

Connection Specs |
[+- 43801 Facility Circuit
- 43801 Group
Connection type > E: andwidth Link
i Azsignable Bandwidth Link
- DSL Link
Connection specs . Ethernet Link
Ihazsignable Bandwidth Link [e.g. Df
WP Link
[+~ Generic Bandwidth Circuit
[+- Generic Facility
[+- Generic Product

Click the menu icon on the Connection Specs panel list to view other options for using the panel list.

Add Connection Type... menu option

Select Add Connection Type to create a new connection type for the template.

Add Connection Spec... menu option

Select Add Connection Spec to create a new connection spec for a connection type.
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Search menu option

Select Search to search for a specific connection spec on the Connection Specs panel list. When you
click Search, the view of the panel list changes. Enter any part of a connection spec as search criteria
in the Connection Spec field, and click the Search button.

To narrow your search using the connection type or status, click the Advanced Search link.

NETWORK TEMPLATE DETAIL PANEL LIST

The Network Template Detail panel list provides a view of the component types and relationships that
comprise an opened template. This panel list is blank until you open a template in the Network
Template window. The following figure shows the Network Template Detail panel list as it appears
with the MetaSolv TM ATM Core Network template opened. The ATM Switch component type is
listed and the connection specs for the relationship also appear.

Metwork Template Detail I
= 1 etaSoly Th AT Care Metwaork,

Intra
=l Companent Types
- ATM Switch
=- Relationzhips
= ATM Switch - Intranetworking - AT M Switch AT Switch

- Azsignable B andwidth Link

|nverze Multiplexing Group [e.a. 4.5M, BM, 7.5M]
Mew Connection Spec

i Unassignable Bandwidth Link [e.0. DS1/E1)

Buttons and zoom features

Save button

EI Click this button to save changes made to a template. When you click the button, the
application performs validations on the work you’ve already completed. If you forgot to populate a
required field, the system prompts you to provide the missing information.

Tip

MetaSolv recommends that you save often while working with templates. Save each time you
add or delete a component type or relationship.
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Select Zoom In and Select Zoom Out buttons

e Click the minus or plus button and highlight the area on which you want to zoom in or out by
dragging the cursor across the canvas to create a stretch box.

Zoom In and Zoom Out buttons

Click these buttons to increase or decrease the size of all images on the canvas in preset
increments.

Zoom Percentage drop-down

oo =l Select a percentage from the drop-down to set the size of all images on the canvas. The
default value is 100 percent.

Tip

When you change the size of an image and then save and close the template, the new size of
the image is retained when that template is reopened.

Printing graphics

You can print the graphical canvas of any network template.

1. Open the network template you want to print.

2. Right-click the graphical canvas, and select Print Graphics.
3. Select the target printer in the Name field.

4. Define the print properties if necessary, and click OK.

PRINT GRAPHICS SETUP

Before printing, you can check your setup so the graphics print correctly.
1. Open the network template you want to print.
2. Right-click the graphical canvas, and select Print Graphics Setup....

3. Define the print graphics setup as desired, and click OK.
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Print Setup ﬂil

— Paper
Size: | etter -
Saurce: | o Select |
— rigntation b argines [Inches]

" Portrait Lett: |1 Right: |1
" Landscape Top: |1 Eottam: |1

—Page Content
£ Curent Yiew on Single Page

£ Ertire Drawing on Singls Fage
™ Ertire Drawing on Multipls Pages

200 I 3&&1['1&5 Ithes:t:de Total pages:l

oK I Cancel | Frinter... |
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Exporting graphics

You can also export graphics from a network template to your workstation. The graphics can be
exported in either Windows Enhanced Metafile (*.emf) or Windows Bitmap (*.bmp) format.

EXPORT VISIBLE GRAPHICS

Use this option to export only those network template graphics that are visible on the graphical
canvas. For example, the graphical canvas below shows only two of five network component types in
a network template. The other three component types don’t fit on the window.

{1
“T_'L«J\

The .emf file that is exported using this option will contain the above graphic and won’t contain all
the graphics in the network template. To export visible graphics, do the following:

1. Open the network template you want to export the graphics from.
2. Right-click the graphical canvas, and select Export Visible Graphics....
3. Select the target location, name the file, and click Save.

EXPORT ALL GRAPHICS

Use this option to export all network template graphics, regardless if they are visible on the graphical
canvas. In the example above, the graphical canvas only shows two of five network component types,
but the .emf file that is exported using this option will include all five component types. To export all
graphics, do the following:

1. Open the network template you want to print.
2. Right-click the graphical canvas, and select Export All Graphics...

3. Select the target location, name the file, and click Save.
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Tip

If you export all graphics and they are not visible on the graphical canvas, you will have to
manipulate the file before you can print it. It is easier to make all graphics visible on the
graphical canvas, and then use the Export Visible Graphics... option.

Closing templates

There are two ways to close a network template. One method is to click the X , located at the top
right corner of the Network Template window. The second is to right-click the graphical canvas, and
select Close Template.

If you made any changes to the template since it was opened, the application prompts you to save
your work when you close the Network Template window.
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Creating a new template

When you create a new template, you should first identify the component types and connection specs
that will make up your template. If you need to create new component types or connection specs, do
that prior to starting the creation of your template.

If you are using component types and connection specs already defined in the application, you can
skip ahead to the Create a new template section of this chapter.

Creating new component types

If you need component types that do not exist in the application, perform the following steps:

1. Select the Inventory Management group on the navigation bar, and click Inventory Management
Setup.

2. Under Network/Equipment, click the Network Templates link.

[ricr ]
3. Select the Component Types panel list, and click the menu icon.
4. Select Add Component Type... from the menu list.

5. Complete the General view of the Managing a Component Type window.
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#'Managing a Component Type 2 2]

General MNew Component Type

Custom Attributes v Component Type

Element Types
v Component Type Mames:

|

Image Mame:
| Mone) = | Browse...

¥ fctive

I Corntinuous Add . I Cancel

REQUIRED FIELDS—GENERAL VIEW

Component Type: A user-defined abbreviation for the component type. This abbreviation
must be unique and is limited to 10 alphanumeric characters. This abbreviation appears in
other areas of the application, and should be easily recognizable by other users, for example,
ATM_SW for ATM Switch and CE_RTR for Customer Edge Router.

Waming

When you click OK, you exit the window. You cannot change the Component Type
field when you reopen the window. Instead, you must delete the component type and
create a new one with the correct entry in this field.

Component Type Name: A user-defined name for the component type. The name must be
unique and is limited to 41 alphanumeric characters. This name appears in the Component
Types panel list.

OTHER FIELDS—GENERAL VIEW

Image Name: You can select one of the pre-loaded images from the drop-down list or use one
of your own images. Any image you want to use must be in .emf format. For instructions on
how to attach your image, refer to the steps at the end of this chapter.
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Active: Indicates that this component type can be added to any template and then used to build
network systems, be placed on an order, and provisioned against.

Tip

If this checkbox is not checked on the Managing a Component Type window, the
component type can still be added to a network template. However, the component type
will not be active in the template and cannot be used to build a network system. To
activate the component in the network system, you must first activate the component
type in the Component Types panel list. Then, you must activate the component type in
the network template.

6. Click the Custom Attributes link.

This view lists the custom attributes that are attached to the component type. If you are creating a

new component type, this view is blank until you use MetaSolv Solution Utilities to attach custom
attributes. After you attach custom attributes to the component type, they are visible when you re-
open the component type.

Tip

When associating custom attributes in MetaSolv Solution Ultilities, the building block
term used is “Element” instead of ““Component.”

7. Click the Element Types link.

Network elements are logical groupings of equipment resources that work together as a single
logical unit in the network. They can be passive groups of equipment such as repeaters, or active
groups of equipment such as digital cross-connects. MetaSolv Solution categorizes network
elements into types based on the technology the equipment supports and the role the equipment
takes. For example, an IP Router has a technology type of IP, and plays the equipment role of a
router.

To create network elements in network design using a component, the template component type
must be associated with a network element type. When you associate a template component type
with a network element type, you are indicating that the component type should be a network
element when used in network design. Associating a network element type is not a requirement in
MetaSolv Solution.
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8. Double-click Add Network Element Type Association.

2=

.___.'"Managing a Component Type

General New Component Type
Custom Attributes Element Types

Element Types rk Element Type Association

™ Continuous Add | oK I Cancel

9. Select the desired network element type(s) on the Select Network Elements Types window.

# Select Network Element Types i |
| I arne Source Active
Syztem Supplied  [Yez .

ATh Switch Rouker Syztem Supplied  Yez

D51 Multipleser Syztem Supplied ez

Frame Felay Switch Syztem Supplied  Yes

Frame Relay Switch Router Syztem Supplied  Yes

Frame Relap/ATk Switch Bouker Syztem Supplied  Yes

Label Edge Rauter Syzterm Supplied

Label Switch Router Syztemn Supplied

FPLS Switch k Syztem Supplied ez

R oter Syztem Supplied ez
SOMET ALk Syztem Supplied  Yez
SOMET CrozzConnect Syztem Supplied  Yes

TOM CrozzConnect Syztem Supplied  Yes

Woice (3 ateway Syztem Supplied  Yes

Wioice Switch Syztem Supplied  Yes

WDk ALK System Supplied  Yes

WO CrogzConnect Syztem Supplied  Yez

Fk. I Canzel
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Tip
On the Select Network Element Types window, you can use Ctrl+left+click and

Shift+left+click to select multiple network element types to associate with the
component type.

10. Click OK.

The selected network element types are associated with the component type.

__!_.'"Managing a Component Type

General New Component Type
Custom Attributes Elemert Types

D Add Network Blement Type Associstion
AT Swvitch
Lakel Switch Router

Element Types

[T Continuous Add [ I Cancel

11. Click OK to close the Managing a Component Type window.

[rinr
12. On the Component Types panel list, click the menu icon and select Refresh from the menu
list.

The new component type appears under the Component Types panel list in alphabetical order by
Component Type Name.
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Viewing connection types and connection
specs

To view the available connection types and specs, perform the following steps:

1. Select the Inventory Management group on the navigation bar, and click Inventory Management
Setup.

2. Under Network/Equipment, click the Network Templates link.

3. Select the Connection Specs panel list.
A list of connection types appears.

4. Expand a connection type to view the connection specs available for use.

= Connection Specs

[+ 43801 Facility Circuit
- 43801 Group
. Bandwidth Link
- Agsignable Bandwidth Link
- DSL Link
Ethernet Link
|Inazzignable Bandwidth Link [2
PN Link
H- Generic Bandwidth Circuit
H- Generic Facility
H- Generic Product
H- Generic Special
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Creating a new connection type

If you need connection types that do not exist in the application, perform the following steps:

1. Click the menu icon on the Connection Specs panel list.
2. Select Add Connection Type... from the menu.

3. Complete the Connection Type — New window.

# Connection Type - New 2| x|

v Connection Type:
[ - |

v Mamne:

|

v Cateqon:

| =l

v B A TOR:

| =l
W Active

[T Cortinuols Add | Ok I Cancel

REQUIRED FIELDS

Connection Type: All connections within MetaSolv Solution are designated as one of three
pre-loaded types: Physical, Virtual, and Group. The connection type selected will restrict the
connection specs that can be associated with it. For example, if Physical is selected, the system
will default all new connection specs under that connection type to Physical.

Name: The user-defined name of the connection type that will appear in the Connection Specs
panel list. The name must be unique and is limited to 43 alphanumeric characters.

Category: MetaSolv uses this field to further classify connections. Any connection spec added
to this connection type will default to the same category selected here. The category field
selected here determines how you classify and search for a connection created in network and
connection design. For more information on how to create a new category and where that new
category appears in the application, see the Creating a valid value for the Category field
section at the end of this chapter.

BW/TDM: Selecting Bandwidth allows you to use bandwidth allocation instead of channels
for the connection. Selecting Time Division Multiplexing assumes that the connection can
have channels.
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OTHER FIELDS

Active: Indicates that connection specs under this connection type can be activated and used to
build network systems, be placed on an order, and provisioned against.

Tip

If this box is unchecked, all the connection specs listed under this connection type are
inactive and cannot be used when designing networks. Activating the connection type
does not automatically activate all connection specs under it, however. You must

manually activate each connection spec. So, you can have an active connection type and
only some of the connection specs under it in an active state.

4. Click OK.

Creating a new connection spec

If you need connection specs that do not exist in the application, perform the following steps:
1. Select the menu icon on the Connection Spec panel list, and select Add Connection Spec....

2. Complete the General view of the Managing a Connection Spec window.

@ Managing a Connection Spec 21%]

General New Connection Spec
Related Connection Specs v Conneclion Tupe Mame: 0 o s Bl
Tranemiession Parameaters | New Cornection Type =l |Physical Conneclion Jzsignable Group
Custom Attributes » Connection Spec Name: + Mullipoint Type;

! | =]

Min Specs Requred Per System; M ax Specs Allowed Per Systent

v Min Connections Requred Per Spec: Max Conneclions Alowed Per Spec:
i

Capacity Calculstion:
[Marne) =]

¥ Assignment Requied ¥ Active [ Autold

[ Continuous Add eoachy MotEulEs

Qb | Cancel

REQUIRED FIELDS

Connection Type Name: This drop-down contains a list of all connection types that currently

exist. The connection spec you are creating will be located under the connection type chosen
here.
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Connection Spec Name: A user-defined name for the connection spec. The name must be
unique and is limited to 42 alphanumeric characters. This name appears under the connection
type selected in the Connection Type Name field.

Multipoint Type: At the present time, all connections function as Point-to-Point and this field
does not drive anything in the application. MetaSolv plans future functionality for multi-point
connections.

Min Connections Required Per Spec: Indicates the minimum number of connections that are
required for the connection spec when designing network systems. The application validates
this value when you later use this connection spec to build a network system.

For example, you set this value to “2” and later use this connection spec to build a network
system. If you only add one connection to your network using this connection spec, you
receive an error message informing you to add another connection.
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OTHER FIELDS

Min/Max Specs Required Per System: The minimum and maximum number of connection
specifications required in a network system.

Capacity Calculation: Used for a Digital Loop Carrier system, this field specifies how to
handle the transmission rate for segments of a multi-point connection. You can add the
transmission parameter for each segment, or use the transmission parameters of the
connection.

Assignment Required: Always check this box if you want to be able to assign a virtual to a
physical connection. An example of when you might not want to check it is for an
Unassignable Bandwidth Link, since the assignments should be against the group and not the
individual connection.

Active: Indicates this connection spec can be used to build network systems, be placed on an
order, and provisioned against.

Tip

If this box is not checked, you can still associate the connection spec on the Connection
Specs view of the Managing a Template Relationship window. However, it will not be
available to add to your network design on the Managing a Connection window.

Auto ID: If checked and a connection is placed on an order using this connection spec, the
system generates a unique connection ID when the CKTID task is opened. Refer to
Automation in templates, later in this chapter.

Capacity Mgmt Rules: Used for Digital Loop Carrier systems, capacity management
specifies which ports get counted when calculating capacity on the Capacity Management
Report. MetaSolv Solution separates the transport provided by a facility from the service
provided by equipment ports. The division of transport and service maintains inventory and
provides accurate capacity reports.

3. Click the Related Connection Specs link.

This view allows you to relate existing connection specs to the new connection spec. You do this
to identify what connection specs can be provisioned over the connection spec you are creating.
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4. Double-click Relate Connection Spec.

# Managing a Connection Spec 7| x|
Gomerg] MNew Connection Spec
Related Connection Specs Cormection Spec Name Relationzhip Type Min Requred  Max Allowed
Trsnemission Pacametars MR nection Spec h;
Custom Attributes

[ Continuous Add Custom &tfiibutes | | (Cepaciy MabH .|=.<| | 0K I Cancel |

5. Expand the appropriate connection type to locate the connection spec you want to relate.

6. Check the box to the left of the connection spec you want to relate.

__._."'EEIEI:I: Connection Specs -

43801 Facility Cincust [Physical Connection]
- 438071 Group [Group Connection]

Generic Facility [Physical Connechion]
Generic Product [Physical Connection]
Genernic Special [Physical Connechion]
Genernic Trunk [Physical Connechion]
Genernic Yirtual Circut [Physical Connection]
GR-303 Facility Circut [Physical Connection)
GR-303 Group [Group Connechon]

R |

L= |

El B andwidth Link [Physical Connection]
. [E-l  Assignable Bandwadth Link
E& D5L Link
E-[]  Ethemet Link
|:| IUnassignable Bandwadth Link [e.q. D51/E1)
E-[]  ¥PH Link

Genernic Bandwidth Circust [Physical Connection)

Inverse Multiplexing Group [e.g. 4.5M, B8, 7.5M)] [Er-:n.iill
: 3

Canzel |
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To view the connection specs that are already related to the selected connection spec, expand it.
(Note: You can also view and change related specs by opening the connection spec properties, and
selecting the Related Connection Specs view.)

# select Connection Specs - e |

- ssignable Bandwadth Link
[ ----- CE Commumity

----- CPE - bazed YPH Connection
----- Enterprize Connection

----- Intemet Connechion

----- Layer 2%PH Connechion

Related | | | ¢ = L5F [Label Switched Path)
connection < ----- M anagement PYC
specs | | i i o Metwark - based VPN Connection

----- Switched Wirbual Circuit [SVC]
----- TL&M - Transparent LAN

----- WLAN - Intemnet Connechion
----- WLAN - Wirtual LAN

CBl: o = Yoice Connechon

D5L Link

] Ethemet Link =
! e T.WLIJ

| ] I Cancel |

7. With this window open, relate any other applicable connection specs.

o0

8. Click OK.
9. Make a selection from the Relation Type drop-down list.
¢ Assignment—Indicates you can assign the child connection type to the parent connection.

¢ Aggregation—Indicates the child connection type is a member of a group whose aggregated
bit rate defines the bit rate of the parent group.

¢ Assembly—Indicates a grouping that does not aggregate bit rates, such as a GR303 interface
group.

10. Complete the Min Required and Max Allow fields as appropriate.

11. Click the Transmission Parameters link.

This view allows you to attach rate codes to a connection spec.
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12. Double-click Add Rate Code.

# Managing a Connection Spec o d .1

New Connection Spec
w3 Rale Cade Trarsmission Rate Asmc/Sne
W] dd R

Transmission Parameters

Custom Attributes

= Continuous Add [Fapacty Moy hiuls | ITI Cancel I

13. Select the appropriate transmission rates on the Select Rate Codes window.
Transmission rate codes are entered through Inventory Management Setup>Connection Design
— Transmission Rate Codes.

Tip
On the Select Rate Codes window, you can use Ctrl+left-click and Shift-+left-click to
select multiple rate codes at one time.
14. Click OK.

15. Click the Custom Afttributes link.

This view lists the custom attributes that are associated with this connection spec. If you are
creating a new connection spec, this view is blank until you use MetaSolv Solution Utilities to
attach custom attributes. After you attach custom attributes to this connection spec, you must
reopen the connection spec to see the custom attributes.

16. Click OK.
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Creating a new template

Establishing the basics

1. Select the Inventory Management group on the navigation bar, and click Inventory
Management Setup.

2. Under Network/Equipment, click the Network Templates link.

[rinr
3. On the Network Templates panel list, click the menu icon, and select Add Template...
from the menu list.

4. Right-click the graphical canvas, and select Properties.

5. Complete the General view of the Managing a Template window.
mplate 5!

| # Managing a Tem
General NewTemplate (2)
Custom Attributes v Template Type:

[ |

v Metwark Template Mame:
[HewT emplate [2)

+ Extermnal/intemal:
Jlnternal Configuration of a Spstem |

W fctive

(] I Cahizel |

REQUIRED FIELDS

Template Type: This drop-down list contains all of the technology modules. The template
you are creating will be grouped under the technology module that you select.

Network Template Name: The application automatically generates a unique name for the
template. The number that appears in the parentheses indicates the number of templates that
have been added in this database. To change the name of the template, type a new name in the
Network Template Name field. The name is limited to 50 alphanumeric characters.

External/Internal: Select Internal Configuration of a System if you plan to use this template
to create provider (backbone) networks. Select External Configuration of a System if you plan
to use this template to create customer (ordered) networks.
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Note: If you will use the template for customer networks and it is not marked as External, you
will not be able to associate it with product specifications when creating the product catalog.

OTHER FIELDS

Active: Select this checkbox to indicate that this template can be used for designing a network
system.

Tip

MetaSolv recommends that you do not select the Active checkbox until you have
completed creating your template. This prevents others from using the template before it
is finished.

6. Click the Custom Attributes link.

This view lists the custom attributes associated with this template. If you are creating a new
template, this view is blank until you use MetaSolv Solution Utilities to associate custom
attributes. After you attach custom attributes to the template, you must reopen the template to see
the custom attributes.

7. Click Save.

At this point, you have named your new template, designated its associated technology module and
whether it will be used for internal or external configuration, as well as whether it is available to be
used to design network systems.

The top of your screen now reads “Network Template — *, followed by the name you designated. On
the left side of the window, the Network Template Detail panel list is expanded. Next, you must add
component types and relationships to the template.
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Adding component types

1.

2.

Click the Components Types panel list.

Select the component type you want to add to your template.

Left-click, hold, and drag the component type to the graphical canvas.
Right-click the added component type on the graphical canvas, select Properties.

Complete the General view of the Managing a Template Component Type window.

General

Groups Component Label; v Image Scale %:
| [100
Component Tvpe Marme:
{Router
in Requred Per System; b ax Allowed Per System;
I [
v Dutside Szsignments: + Baze Component:
[1z31e & warming =] | 4|
[¥ Location Required [v Ao Equipment at Multiple Locations
[ &llows Port Association [¥ Orderahle
[ Metwork Extension [ Active

ok | Cancel |

REQUIRED FIELDS

Image Scale %: Indicates the size of the component’s graphical image expressed as a

percentage of the canvas default. Although you set the image scale percentage in the network

template, you only see its effect in network design.
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Outside Assignments: Identifies whether this component type can have connections assigned
to it from a foreign origin.

¢ Allow—Assignments can be made from a foreign origin, and the reduction of available
capacity due to such assignments cannot be computed by the application.

¢ Do not allow—Assignment cannot be made from a foreign origin.

¢ Issue a warning—Assignments can be made from a foreign origin but a popup message
will appear warning the user.

Base Component: This field is enabled specifically for component types used in a DLC
network template. This field indicates the component type is the one to which a service item is
connected last.

¢ Primary Base Component—The last component type to which service is connected. For
example, a Local Digital Switch (LDS) is the last component type to which a connection
"riding" a DSO connects.

¢ Secondary Base Component—For example, the component type is the Digital Cross-
Connect System (DCS).

¢ Not a Base Component—Intermediate component types, for example, the Central Office
Terminals (COTs) and Remote Digital Terminals (RDTs).

OTHER FIELDS

Component Label: A user-defined label for the component type, limited to 43 alphanumeric
characters. The label entered here appears on the graphical canvas underneath the component
type graphic, but does not replace the name of the component type in the Component Types
panel list.

Tip

The component label does not need to be unique. You can use the same label for other
component types added to your template. Because the system only allows you to add
one component type to a template, there’s no way to duplicate. The component type
and label can also be used in multiple templates without being unique in each one.

Component Type Name: The name of the component type as it appears in the Component
Type panel list. This field is disabled and cannot be changed on the Managing a Template
Component Type window.
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Min Required Per System: Indicates the minimum number of similar system components
that must exist in a network system when this component type is used. For example, in the

ATM Core Network template, this field is set to “1” for the ATM Switch component type.

This means that each time this template is used to build a network system, you must add at
least one ATM Switch.

Max Allowed Per System: Indicates the maximum number of similar system components that
can exist in a network system when this component type is used. For example, if in the DSL
Network template this field is set to “4” for the DSLAM component type, you can only add
four DSLAMs to the DSL network system. The application performs validations based on the
value entered in this field.

Location Required: Indicates the Network Location field will be required on the Managing
an Element window when you use this component type in a network system. This field is
checked, by default.

Allow Port Association: Indicates you can associate port addresses with a specified
component.

Network Extension: Indicates this component type is an extension of the provider’s network.
For example, in the DSL Network template, the Customer Site component type is a network
extension. Selecting this checkbox allows you to design orderable connections out to this
component. When you use this template to design a network system, this component type is
not visible. Design of each of the ordered network extensions is done during connection
design.

Allow Equipment at Multiple Locations: Indicates you can associate equipment from
multiple locations with a component. This field is checked, by default.

Orderable: Indicates this component can be placed on an order for a customer. This field is
checked, by default.

Active: Indicates this component type can be used to design a network system. This field is
checked, by default.

6. Click OK.

7. Repeat steps 1 — 6 to add other component types to the template.
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Adding relationships and associating connection specs

After you add component types that represent the possible components that make up your network,
you establish the relationships that can exist between those components in your network. After you
establish relationships between component types, you associate connection specs with those
relationships.

1. On the graphical canvas, right-click one of the two component types you want to create a
relationship between, and select Connect.

2. Drag the cursor to the other component type you want to create the relationship between, and left-
click.

| _;. ______ I‘

= Intr= —s> |
Component Type 1 | Component Type 2
| LI u

3. Right-click the relationship just added between the component types, and select Properties.
4. Complete the General view of the Managing a Template Relationship window.

- qu emplate Relation |

General

e e v Intradlnker Mebworking

Hnitapehworking 34
Component Type 1 Role:

| Mone] |
Component Type 2 Role:

][N one) ;l

tinimnurn Reguired:

bl asirnurn Allovwed:

[k I Cancel
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REQUIRED FIELDS

Intra/Inter Networking: Identifies whether the relationship between two component types is
within the same network or between two different networks.

¢ Intranetworking—The relationship exists between component types in the same network.

¢ Internetworking—The relationship exists between component types in two different
networks.

OTHER FIELDS

<Component Type 1> Role: This field name is automatically populated with the first
Component Label you selected on the graphical canvas to create the relationship between.

<Component Type 2> Role: This field name is automatically populated with the second
Component Label you selected on the graphical canvas to create the relationship between.

¢ Authentication—Select only if the component type is a server with this role in a
management network.

¢ LSR—Supports Label Switch Routers. Select only if the component type is an ATM
switch enhanced to support MPLS.

¢ None—Select if the component type does not serve one of the other two roles specified.

Minimum Required: The minimum number of secondary components you can connect to
each primary component.
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Maximum Allowed: The maximum number of secondary components you can connect to
each primary component. For example, in the relationship between a local digital switch
(LDS) and a central office terminal (COT) in the DLC Network template, this field is
populated with “1” because only one COT should be connected to a single LDS.

Tip

As mentioned earlier, the template can restrict the number of components that can be
added to a network system. This is done with the Min Required Per System and Max
Required Per System fields on the Managing a Template Component Type window.
If you set these fields to restrict the number of components to one, you don’t need to
enter anything in the Minimum Required and Maximum Allowed fields on the
Managing a Template Relationship window.

5. Click the Connection Specs link.

This view allows you associate connection specs with the relationship you created between two
component types. When you later build a network system using this template, the only types of
connections that will be available to be built between these two components are the ones
associated here.

6. Double-click Associate Connection Spec.

Ir}ll emplate Relation EI

General

Connection Specs

Connection Type

> Connechion Spec

] I Cancel
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7. Expand the appropriate connection type to locate the connection spec you want to associate.

8. Select the box to the left of the appropriate connection spec.

'.‘ Select Connection Specs -

43301 Group [Group Connechion]

B~  Bandwidth Link [Physical Connection]
- Azsignable Bandwadth Link,
..[]  DSL Link

o[ ] Ethemet Link

------ WPMN Link

enenc Facility [Physical Connechion)
Genernc Product [Phwsical Connechion]
Genenc Special [Phwsical Connechion]
Genenc Tuunk [Physical Connechon]
enenc YWirtual Circust [Phwsical Connection)

3R-303 Group [Group Connechon]

wl —

----- % Unassignable Bandwadth Link [e.g. DS1/E1)

Genenc Bandwidth Circust [Physical Connechion]

3R-303 Facility Circut [Phwsical Connechion]

o]

|reverze Multiplesing Group [e.o. 458, B, 7 5M] [GrDLi;LI
e e . R

Cancel |

9. With the window open, associate other applicable connection specs.

10. Click OK.

The associated connection specs appear below the Associate Connection Spec title.

11. Double-click a connection spec and complete the appropriate information on the General view of
the Managing a Template Connection window.
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i

r #'ranaging a Template Connection

P ——— P —

=
General Connection spec Assignable Bandwidth Link from element type Template Compaonent 1 to
element type Template Compaonent 2

v Outzide Azsignments:
g pet dlwy R

™ Direct Conneclion

I Hetwark Extension

[ Ues Mew Available Bandeidih Parzmeter fon Azzigrmants
P Inchede Optional Labe|

[~ Comnection Spac Requied

1] I Cancal

REQUIRED FIELD

Outside Assignments: Identifies how the application responds when an assignment is made
outside of itself.

¢ Do not allow—The application will not let you make an outside assignment.
¢ Allow—The application will allow you make an outside assignment at any time.

¢ Issue a warning—The application will notify you that an outside assignment is being
made, but will allow you to proceed.

OTHER FIELDS

Direct Connection: Indicates if this is a connection between two components only. Do not
check this field if the connection passes through multiple elements. This field is informational
only and does not have functionality associated with it.

Network Extension: Indicates the connection is an extension of the provider network and not
part of a backbone network. If checked, design will occur during the connection design
process instead of the network system design process. This checkbox is not available for the
Optical technology module.

Use Next Available Bandwidth Parameter for Assignments: Indicates the next available
parameter (for example, DLCI, VPI/VCI) is the default in the provisioning dialogue. You can
then use this value or overwrite it during the provisioning process. If left unchecked, there is
no default value. You must enter the value. This checkbox is not available for the Optical
technology module.
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Include Optional Label: Indicates the use of the connection spec is optional in any network
that connects two components as defined by the template. Applies only to optional
connections. If unchecked, the application does not create optional connections when the
parent network system is created. This allows you to associate connections "as you go."

Connection Spec Required: Indicates the connection spec will be automatically associated
with a relationship when the network components are connected during network design. The
Include Optional Label checkbox is overridden when this checkbox is checked.

12. Click OK.
13. Click the Assignable Connection Specs link.

This view is only available when you associate a virtual connection spec on the Managing a
Template Relationship window.

l # Managing a Template Connection x|

Ganeral Connection spec Intermet Connection from element type End User to element type IP Router

Asslgnable
Connection Specs

™ Assigrwnent raquinad al End Ugsr
[ Azsigrmert roquied at I Router

Azzignable Connection Spec Axsigament Reguied
[[] Aed Azsignable Cannection Spec

Priorifized Paths

d X
[ ox ] canca |

FIELDS

Assignment required at <Component Type 1>: Checking this checkbox requires the
connection designer to make an assignment on the first connected component of the virtual
connection.

Example: On the Managing a Template Connection window above, you would check the
Assignment required at End User checkbox if you want to capture the port the customer
connects to on the customer premise equipment. Once this port assignment is made, that
information is added to the graphical layout record.
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Assignment required at <Component Type 2>: Checking this checkbox requires the

connection designer to make an assignment on the second connected component of the virtual
connection.

Example: On the window above, you would check the Assignment required at IP Router
if you want to capture the port on the equipment that faces the rest of the provider network.

Once this port assignment is made, that information is added to the graphical layout
record.

To later design virtual connections, you must identify the assignable connection specs that the
virtual can ride between two components. You must provide for every possible path the virtual
can take between the components. If you do not add the assignable connection specs, when you go

to design this type of virtual connection using this template, you receive an error message stating
that no available connections exist.

14. Double-click Add Assignable Connection Spec.

[ # +anaging a Templabe Connection

i

General Connection spec Internet Connection from element type End User to element type IP Router
Assignable
Connection Specs

I~ Azsignmen ieuired & End Lzer
Priortized Paths 8 Assignment 1ecuited o IF Fioutes

Azzignable Connection Spex Asigrment Requined
] 2 e A
| *
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15. On the Select Assignable Specs window, expand the template relationships to locate assignable

connection specs for the virtual connection.

16. Select the checkbox to the left of the appropriate connection spec.

@ select Assignable Specs 2=l

AT Swabch - Inranetworking - 1P Flouter,
e Aezigrnable Bandwidih Link
] .é_u'[:@ Swatch - Intrangtwaiking - SMS
4 End Uszzs « Intranetwarking - AT Switch
#- End Usger - Inkanetworking - 1P Router
] SMS - Irtianetwotking - |P Rouler

ok | camca |

17. With this window open, select other assignable connection specs as applicable.
Tip

The Select Assignable Specs window lists all relationships that exist in the template.
Only the physical type connection specs have checkboxes available for you to add. If
you do not see a relationship with a connection spec you need to design your virtual

connection, check to ensure the relationship and connection spec exist in the template.
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18. Click OK.
| # Managing a Template Conmection . o x|
General Connection spec Internet Connection from element type End User to element type IP Router
Assignable
Connection Specs
| ™ Assignment recuited st End Liser
el [ sigament iequited 2 IP Fioutes
Azgignable Conmection Spex =]
Azsignable Bandwidth Link [ ATH Switch
1P Rouse
Aasignable Bandwicth Link [ ATH Seitch
[ 5M5
Axsignable Bandwecdh Link [ End User -
T ATH Switch
4 | i
ok | caeen |

FIELD

Assignment Required: Check any of these checkboxes to require the connection designer to
capture the port assignment for the virtual connection as it passes through each piece of
equipment.

19. Click OK.
20. Click OK.

21. Click Save [=.
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Example scenario

Following is an example of network templates created to support two ATM Access networks, and one
larger network containing the two ATM Access networks.

Provider networks built

Following are illustrations of the provider’s three networks.

ATM Access NETWORK 1

‘ Assignable BW
PSTH

| GRaos | Gs“i‘/
e

1 AT Switch

Component types

Network 1 was built using three component types—ATM Switch, Voice Gateway, and Public
Switched Telephone Network (PSTN). In this network there is only one instance of each component

type.

Connections

Two physical connections exist in this network—an assignable bandwidth connection between the
ATM Switch and the Voice Gateway and a GR-303 facility connection between the Voice Gateway
and a voice switch in the PSTN.
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ATM Access NETWORK 2

7

OP IP Metwark
Assignable BW

IP Router

ATh Switch ATh Switch 2

Component types

Network 2 was built using three component types—ATM Switch, IP Router, and the Other Provider
(OP) IP Network. In this network, there are two ATM Switches and only one instance of the IP
Router and the OP IP Network.

Connections

Four physical connections exist in this network—an assignable bandwidth connection between the
two ATM Switches; assignable bandwidth connections between each of the ATM Switches and the IP
Router; and an assignable bandwidth connection between the IP Router and the OP IP Network.
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NETWORK 3

3
OF 1R Metwork

IP Router

~

ATH Switch ATH Switch 2

Internet

Assignable BW

@ Enterprise
End User End User

Component types

Network 3 was built using three component types—embedded ATM Access Network 1, embedded
ATM Access network 2, and End User. The End User represents the provider’s customers and their
access into the provider network for service.

Connections

Seven connections exist in this network, four of which are physical and three virtual:
® An assignable bandwidth connection between the End User and the ATM Switch in Network 1
® An assignable bandwidth connection between the End User and both ATM Switches in Network 2

® An assignable bandwidth connection between the ATM Switch in Network 1 and ATM Switch in
Network 2

e A voice connection between the End User and the PSTN in Network 1
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¢ An Internet connection between the End User and the OP IP Network in Network 2

® An enterprise connection between End Users in Network 3

Templates created

To build networks 1, 2, and 3 in MetaSolv Solution, two templates were created. The first template
(New Regional Template) was used to create both ATM access networks. The second template (New
Global Template) was used to create Network 3.

NEw REGIONAL TEMPLATE

Network 1 and 2 are both ATM access networks, so one template was created to build both. Because
one template was used to build two networks, all the component types of both networks must be
represented in the template. Remember that when creating templates, you only add one instance of
each component type.

The following figures illustrate the information entered for the New Regional Template.

Template Properties

General New Regional Template
IO ULGER  » Template Tope:
[ETM_FR =l

v Metwork Template Mame:

M ew Reagional T emplate

v Extemnal/lrtemal.
| Intemal Configuration of & System |

[+ Active

| OF. I Cancel
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Component types

network Template - New Regional Template

File w Edit+ ‘Yiew Options »  Window ‘ Component Types ‘
4 = N
= MNetwork Templates ( w
= Commponent Topes @
Connection Specs \iice Gateway IF Router
M etwark Template Detail /w\\
=- N_ew Regional Template
=k |:_|:lr|'||:u:l nent Types @
- PSTH Switch
: . i OF IP Hetwark
- ATM Switch ReTH AT Suiteh e
- DP IP Network L j
-~ IP Riouter ~
o Woice 5 ateway
[+ Relationzhips ‘ Component Types ‘

Relationships

network Template - New Regional Template

File » Edit» ‘iew» Options -  ‘Window «

4 =

=) Metwork Templates
Component Types /@\ -
= Connection Specs

= Adice Gateway P Router™,
Metwark Template Detai Irtra Irtra Iritra Irtra

Iri., -
E- N_ew Regional Template
- Companent Types
= ':5:'. 5 5

E witch
AT Switch OF 1P Metwork

%1 PSTH [Public Switched Telephone PSTH

SWoice Gateway - Intranghwarking - AT Switch
-ATH Switch - Intranetwoarking - 1P Router

IF Router - Intranetworking - OF 1P Metwork

‘oo TM Switch - Intranetworking - ATk Switch
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Connection Specs
__.' Select Connection Specs -

Generic Yirtual Ciruit [Physical Connection)
- [3R-303 Facility Circuit [Physical Connection)
v’ GR-303 Facility Circuit

IZIB Group [Group Connection]
Adpice Gateway P Router™,
I,
ATh Switch OP IP Metwoark

. Select Connection Specs -

43801 Gru:uup [Gru:uup Cunnectlon]
B andwidth Link [Phyzical Connection)
Azzignable B andwidth Link

[} D51 Link

: 43801 Gruup [Gn:uup Eu:unneu:tu:un]
El B andwidth Link [Phyzical Connection)
Assignable Bandwidth Link
e D51 Link,

NEw GLOBAL TEMPLATE

This template was used to create Network 3. The following figures illustrate the information entered
for the New Global Template.

Template Properties

J General New Global Template

I LIRS  Template Type:
[ATM_FR x|

v Metwork Template Mame:

Mew Global Template

v External/lntemal:
| Internal Configusation of a Sestem =

v Active

(] I Cancel
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Component types

network Template - Mew Global Template

File w Editw Wieww Options  Window C°mp°;e£t Types

Metwork: Templates

Component Types

e
|Ep | | =

]

LLEY Gateway |f Ruouter Intra

Itra Intra
ra

Connection Specs

Metwork. Template Detail

OP IP Network

End Uzer Location
- Relationships

AT Switch

Mew Regional Template

L End User Location )

‘ Component Types

Relationships

Metwork Template - New Global Template

File » Edit» ‘View = Options »  Window -
4 =
[z

Metwork. Templates

Component Types

Connection Specs

Irtr= IP Rout
“Whice Gateway P Intra
i

Metwork Template Detai

[=]- Mew Global Template

-- Compaonent Types

B- Relationzhips
- Mew Hegi%al Template, ATk Switch - Intranetwork
- End Uszer Location - Intranebwarking - Hew Regional
- End User Location - Intranebworking - End User Loc:
- End Uzer Location - Intranebwarking - Hew Regional
- MetaSaly Tk PSTH [Public Switched Telephone Me

Intra

Intra

OP IP Metwork

Intra

Intra AT Switch
:ln Intra
e Reninnal Templ

Initra

Relationships Relationships

End User Location

s [ )
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Tip

A relationship was added to the New Global Template between the ATM Switches. This
allows for a connection between ATM Switches in different access networks (Networks 1 and
2). Since a relationship already existed in the New Regional Template between ATM
Switches in the same network, a double ring represents the relationship on the graphical
canvas.

Connection Specs

/,..r"'_'_'_\_"“-\ # select Connection Specs -
hY o

R LS 501 y it [P

43801 Group [Group Connection]
Bandwidth Link [Physical Connection]

ASS|gnabIe Bandwidth Link
Irtra ‘hice Gateu.lay IR Hl:-l.rter“‘* DSL Link
!
Intm Intra
= Switch
- Intra [@ select Connection Spees-
- 2 Group [Group Connection) P5ETH |:| P |F MHetwo -
WE.2 Facility Circuit [Physical Connection] "‘\,\. TR-008 Mode 2 Group [G[DUD Connectlon]
4 5.2 Group [Group Connection] AN N
e o Intr AT Switch ...-"'/ 5.2 Facility Circuit [Physical Connection]
[ CE Communiy | S —— Intra Wh.2 Graup [Group Eonnectlon]
-] CPE - based VPN Connection kS Intra \ b L
~-[]  Enterprise Connection / ) CE Eommum "
[]  Intemet Connection .
O Layer 2VPN Cormestion | - CFE - hased WPN E_Ionnectlon
[0 LSP (Label Switched Path] ntra -] Enterprize Connection
[ Management PYC - Internet Connection
- Netwark - based WPH Connection . .-k Layet 2PN Connection
-] Switched Virtual Circuit [SVC) End User Location i
[] TLAN - Transparent LAN
-] WLAN - Internet Connection . Select Connection SDECS 5
-] WLAN - Virtual L&N » .
Voios Connection :
s TR-008 Made 2 Group [Group Cannection)
al [ V5.2 Facility Circuit [Physical Cannection)
43801 Group [Group Connectlon] \.-"5 2 Grou [Grou Connectlon]
_ Bandwidth Link [Physical Cannectian) H b b
. Assignable Bandwidth Link =) J
_ .D% BSL Lirk O CE Commurity

[ CFE - bazed ¥PM Connection

Enterpnze Connection
Internet Canhection
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Assignable connection specs
Intra ‘ice Gateway IP Rauwter™
. ! Intra
Intra Intra
Switch
Intra
OF IP Me

PSTH

\\\
- Intra AT Switch
| ™—Irtra

Intra

Select Assignable Specs

Bl ATM Suilch - Infanetwarking - ATM Switch

Pt Assignable Bandvidth Link

AT Switeh - Intranetworking - IP Router

End User Location - Inlranetworking - New Regional Template, ATM Swiich

Aissignable Bandwidth Link

End User Location - Intianetworking - End User Location

End User Location - Intranetworking - New Regional Template, OF 1P Network

OF IP Network
ii

Intra

End User Location

Select Assignable Specs

Select Assignable Specs

2l

m

MetaSaly Th PSTH (Public Switched T elephane Netrk]. Swtch - Intranetworking - Voice Gateway

-303 Faciity Cirouit B
Vioice Gateway - Intranetwerking - ATM Switch
Assignable Bandwidth Link

ATM Switch - Intranetworking - ATH Sustch
Assignable Bandwidth Link
ATM Switch - Intranetwarking - IP Router

Assignable Bandaidih Link

i
End Liser Location - Inanstworking
P Router - Intraneterking - OP 1P Network

Cancel

Voice Gateway - Inianetworking - ATM Switch

=

AT Suitch - Inlranetworking - &TM Swich
sssignable Banduwidth Link

ATH Suwitch - Intranetworking - IP R outer

Agsignable Bandwidth Link

End User Location - Inianetworking - New Fiegional Template, ATM Switch
Assignable Bandwidth Link

End User Location - Intianetworking - End User Localion

1P Router - Intranetwarking - 0P IP Network
sssignable Banduwidth Link

MetaSolv TM PSTN [Public Switched Telephone Metwk], Switch - Intranetworking - End User Location

MetaSaly TM PSTN [Public $witched Telephone Netwk), Switch - Intranetworking - Voice Gateway
Voice Gatsway - Intranetworking - ATM Switch

Cancel

End User Location - Intranetwarking - New Regional Template, ATM Switch

New Fregional Template, OF IP Network

MetaSol TM PSTN (Public $witched Telephone Netwk], Switch - Intranetworking - End User Loeation
MetaSobe TM PSTN (Public Switched Telephone Hetik], Switch - Intianetworking - Voice Gateway

Cancel

Tip

Remember that assignable connection specs are only necessary for virtual connections.
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Automation in templates

Auto-identifying connections

When the Auto Id checkbox is selected on the Managing a Connection Spec window, the system
generates a unique connection ID for an ordered connection. To assign this connection ID
automatically, you must include either the CKTID task or NETDSGN task in your provisioning plan.

UsING THE CKTID TASK

1. Select the Auto Id checkbox on the General view of the Managing a Connection Spec window.

# Managing a Connection Spec 2=l

General Enterprise Connection

Belated Connection Specs v Connection T:,lp&_ Name: Connection Type: Calegon:

Transmission Parameters [Virbual Correction x| itual Cornection F‘."E

Custom Attributes l;":;:';“;;li‘r‘l:ﬁ =
ed Fer Suslen Max Specs Allowed Per System

v Mlin Conreclions Required Per Spec: M ax Connections Allowed Per Spec:

I ]—
Capacity Calculation:
[IMare] =1

[ Assignment Flequred [+ At IFQMM Id

I” | Contimuous S apa b ot !--.'-'-<~l Ok I Cancel
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2. Place an order for the connection.

File » Edit- View =  Options »  Window «
@ Crder Mumber - 5940

= slobal

w E| -------------- Alaska Enterprise - Mew
P Services

Order Maintenance

------- Access Conneckion-Mew---

Order Actions - Access Conneckion-Mew---

Copy Existing Serwvices - Enterprise Conneckion-Mew---

add Service Location

Assign Telephone Nurmbers

Assign Billing Telephone MNumbers

General Info |F‘ri|:e Info | Label and Yalue Info Summary Info
Update LIDECHAM
validate Order [eneral Dezcription: NZEnterprise Access
Finish Order

Service Item Actions

Add Mew Tkem

3. Assign a provisioning plan and generate tasks.

Tip

Before you open the CKTID task for the first time, the Connection ID field is blank.

Fie» Edite Vieww Optonse Wirdow - Heln

Walk Quews [ASAPSZ =| | = Persond 7 Wark Group Segech Crberla Soatus - Al Dus Date - Al Tasks - all
86 Found

Expedite Order 8 PON Company Hame Task Status Task Act Sup Connection 1D Cug *
5540 JBTATE BEROWMN BUSIMNESS oo
5340 JBTATE EROWN BUSINESS

ERIT BLISINESS

HEW Panding BT, i
5502 HE'Ww FESSI I]EDESIFSH H uI:IHN BROWHS  fASSIGMABLE BANDWIDTH IJMK Jak
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4. In the Work Queue Manager, open the CKTID task.
The system generates a unique connection ID for the virtual connection (the enterprise connection
spec). IDs are only generated for those connections that have the Auto Id checkbox selected on

the Managing a Connection Spec window.

F'lE - Edlt - View - Opkions - 'l'\l'nli:llﬂ -

3 Found
Type Category Activity | dentification Status
Phyzical Bandwidih Mew

Fripsical

Bandwidlh New e )
! LT ] /M ELSIMESS "Er'te-!plF'-:r'u:Iir'ug

Tip

The format of the automatically generated connection ID is OTS (free-format). For this
reason, don’t select the Auto Id checkbox if you use standard connection ID formats. Once
the connection has been named, you cannot open the connection ID and change the
Connection Type field.

5. Open the assigned connection ID and change the Service Type Code field as needed.

# BROWN BUSINESS,/BROWN BUSINESS /Enterprise Con/10033 Connection Identification - DTS forma e |
i~ Connection Dretals

Cannection Types: | 0TS Formet [Freeformat-Seic = |

Service Tupe Calegory: | CLCL alata |

Service Type Code: i ]

Bill # / Assoc Bil & 4]

Riate Code: [ =l

Connection Descriplion; |

Connection Loc & [BADWN BUSINESS 2

Conrection LocZ:  [BROWN BUSINESS - Farbank 2

r~ Connection |0
Freafoomn Cincug enfny:

[EROWN BEUSIMNESS/BROVWMN BUSINESS /E ntesprize Cond10033

R efresh fram O rdes I Irreeritany.. I Ok I Cancel
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Tip
When automatically assigning a connection ID, the Service Type Code field defaults to

“Z27277> . 1f you use the Service Type Code field to help identify connections, you should
change this field to the correct service type code to prevent any confusion.

6. Change the assigned connection ID, if needed.

i~ Conneclion 1D
Freefaim Creuil entiw
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UsING THE NETDSGN TASK

The functionality of the NETDSGN task includes the ability to name your ordered connections
without the need for the CKTID task.

1.

Select the Auto Id checkbox on the General view of the Managing a Connection Spec window.

. Managing a Connection Spec

2 x|
General VPN Link
Belated Connection Specs EENIARRETReS iRy JEES Cornechion Type: Categony:
SIS | | arichidth Link. | |Physical Conneclion |Bandwidlk
) ornechon Spec M anie: v Multipoint Type:
Cust Attributes
e P Link [P to Paint =]
Min Specs Fequired Par System: M ax Spece Allowed Per System:
I
» Min Connections Required Per Spec: &= Cornechons Allowed Per Spec:
[ 1
Capacity Caleul atioe
| [Mone) =]
[ Azsignment Requisd 3 Ar.l:i
[ Cortinuous Add SavipMatFules| [ o] [ cancat |
# Managing a Connection Spec 7| =]
General Layer 2 ¥YPMN Connection
¥ SOt » Connection Type Mame: Connection Type: Categony
Transmission Parameters TS | [Witual Cormection |PiC
: onnechion Spec Mame + Mullipoint Type:
Cust At ribur
Ll M ayer 2 WPM Connechon [Paint to Port |
Mir Specs Requred Per Syzbem: Max Specs Allwed Pes System:
r [
+ Min Connections Required Par Spec: W ax Connections Alowed Per Spec:
Capacity Calcubation:
|[Mone) =
[ Assigrenenl Flequied [+ a‘:".t
4
T Corfinuzus Add AREs e QK I Cancel

©MetaSolv Software, Inc.

69



CREATING A NEW TEMPLATE

2. Place an order for the connections.

File = Edit= View~ Options -  Window «

ol
Order Maintenance @' Order Mumber - 5941

Order Information E}—— Zesty Comm Layer 2 YPN - New - 99 METRO MED
b Services + Branch Office-Mew - Customer Edge Router---
Order Actions & Branch Office-Mew - Customer Edge Router---
Copy Existing Serwvices + Home Office-Mew - Customer Edge Rouker---

Add Service Locakion YP]H Access Connection-few-—-

fzsign Telephone Mumbers YPH Access Connection-Mew---

&ssign Billing Telephone Mumbers ¥PH Access Connection-Mev---

Ipdate LIDECRARM

Validate Order ¥P] Yirbual Connechion-MNew---
¥P ¥irbual Connection-MNew---

Finish Crder

Service Ibem Actions

£dd Mew Ikem
3. Assign a provisioning plan, and generate tasks.
4. In the Work Queue Manager, open the NETDSGN task.
Tip

Before you open the NETDSGN task for the first time, the Connection ID field is blank.

Fiee Edtw Views Opbonse Windos Help +
Week Queue [B5AP =1 | F Persond i Wark Grovp Search Zritesia Status - Al DueDate -l Tasks - Al
3 Found

Company Hame Task Status Tasg o
SSAETRD MEDICAL |_r-_JET [Z'EiEir'J:F'EiFI ]
41 JSMETAD MEDICAL  MEW Pendirg RID Slamy
5541 SEMETRO MEDICAL  HEW Pendng oo F5H M

|Expedite Order & PON

Heady
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File » Edit» VWiew -+ Options »  Window =

4 HE
Metwork Template Detail 1
£ Ordered Metwork Cetai
= Unincorporated @
nprovizsioned RIH
R 08 Customer Edge Router
Unprovizioned Connections 2800 HOSPITAL BLVWD , DALLAS TH 75248, United States
YPM Link (Mo connection 1d)
- WPN Link (Mo connection 1) @
P Link (Mo connection |d) A

Q3 Customer Edge Router
7799 hMAPLE , DENTOMN TK 768205, United States

- 3

Q3 Customer Edge Router
A609 PARK , PLAND TH 75028, United States

Tip
The NETDSGN task only lists the physical connections (VPN Link) on the Unprovisioned
panel list.
6. Select Connection Identification from the menu list.

The system generates a unique connection ID for the physical connections (VPN Link connection
spec) and the virtual connections (Layer 2 VPN connection).

Type Category Activily Identification Statusz

Py B andwidth FIMETRO MEDICAL - Plano!  APM Link /10036 Fending
Phisical Bandwidth Mew FIMETRO MEDICAL - Dentory'  AFM Link/1 0035 Pendirig
Physical B andwidth Mew SAMETRO MEDICAL - Home!  APM Link/10037 Fending
Wilkual T Mew FAIMETRO MEDICAL/SIMETRO MEDICAL/Layer 2PN C/A10038 Pending
Wirtual e Hew FAMETRO MEDICAL/IIMETRO MEDICALALayer 2 VPN C/10033 Pending
Wilkual T Mew JIMETRO MEDICAL/IIMETARO MEDICAL/Layer 2PN C/10040 Pending

©MetaSolv Software, Inc. 71



CREATING A NEW TEMPLATE

7. Open the assigned connection ID and change the Service Type Code field or Connection ID field
as needed.

8. Click OK.

The automatically assigned connection IDs appear on the Unprovisioned panel list.

File » Edit+ Wiew+ Options »  Window +

4 EE&E
Metwork Template Detail 1 =
= Ordered Metwark. Cetai
= IUnincorporated @
|nprovizsioned i
99 Custamer Edge Router
U!'lprn:wisin:nned Connections 2200 HOSPITAL BLYD , DALLAS TH 75242, United States
WPM Link (99METRO MEDICAL - Dertons  AYPR LinkA 0035
- WP Link (99METRO MEDICAL - Home/  A/PH Link/ D037 @
WP Link [S9METRO MEDICAL - PlanoS  A/PR Link 00367 TR

Q8 Customer BEdge Router
7799 MAPLE , DEMTOMN TH 76205, United States

- 3

989 Customer Bdge Router
G699 PARE , PLANO TH 75026, United States

Assigning prioritized paths

Prioritized paths are the physical paths that a virtual connection can ride through a network. In some
networks, there are multiple paths that are available. MetaSolv Solution allows you to assign a priority
to those existing paths, for use when designing ordered virtual connections.

The figure below shows two virtual paths between the Customer Site component type and the IP
Router component type. The broken lines represent one virtual path (Cust Site — ATM Switch — 1P
Router) and the dotted lines represent a second possible virtual path (Cust Site — ATM Switch — SMS
— IP Router) that exists between the Customer Site component type and the IP Router component

type.
#EH /@

Customer S'rte> ~ - IF'| Router

AT Switch [—
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The Prioritized Paths view is located on the Managing a Component Type window for virtual
connection specs.

1. Double-click a virtual connection you associated on the Manage a Template Relationship window.

General

Connection Specs Connection Spec Connection Type

Intemet Connechon Yirtual Connection

] I Cancel
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2. Click the Prioritized Paths link.

| # Managing a Template Connection E 3 ' x|

General Connection spec Internet Connection from element type End User to element type IP Router

i Assignable
Conmaction -'58[!8

» [ukside dssignments:

Pnnrmzam [ Do not allow I~

[ Diect Connectian

[+ Hetwork Extension
[ Use Naat fvalable Bandwidth Parameter for Azsigrments
[ Inciude Dpticeial Label

[ Cormeclion Spec Requied

| (0] 5 I Cancel

Tip
To establish prioritized paths, you must first complete the Assignable Connection

Specs view. Completion of that view establishes all of the possible physical
connections that can be used in the prioritized paths for the virtual connection.

3. Double-click Add Prioritized Path.

| # Managing a Template Connection : 3]

General Connection spec Internet Connection from element type End User to element type IP Router

l Assignable
Connection Specs
Priontized Path Mame Priceky

M

Prioritized Pathe

| (0] 4 I Cancel
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4. Enter a name or accept the default in the Prioritized Path Name field.

# Managing a Prioritized Path foed

Friontized Path Mamms:

Hew Pricefized Path 1
Inbenmedate Element Tooes

| |»

Felstionshps

End Uzar « Intranabeccking - AT Swatch

1] |+
Select |

Comneclion Specs
Auzsignable Bandwidih Link

(1.8 | Cancel

Tip

The order in which you create the paths determines their priority. For example, the first
path you create will automatically be assigned as first priority and the second path you
create will automatically be assigned as second priority. The name defaulted for each
path contains the priority number. If you change the defaulted name, MetaSolv
suggests that you include the priority number in the new name.

The Intermediate Element Types section indicates the component type the path is starting from.

The Relationships section lists all relationships that exist from the starting component type.

The Connection Specs section lists the connection specs for each relationship that is selected in
the Relationships section.
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5. Select the relationship you want to add from the starting component type, and click Select.

W Managing a Prioritized Path

Frionhzed Path Mamma:
|M e Prisekized Path 1

Intermediate Element Types
End Uzar

ATH Swatch

| |+
Felstionships

ATM Switch - Infrarebwcrking - IP Rouber
AT Swaitch - Infranehsorking - SMS
End User - Inliznetworking - ATM Swilch

o |2

Select

Conneclion Specs
Azzipnable Bandwidlh Link

0F Canced
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6.

7. Continue adding relationships to your path, until you reach the last component type in the path.

Select the component type added to the Intermediate Element Types section, select the next
relationship in the path, and click Select.

2]

# Managing a Prioritized Path

Prionized Path M ame:
|Meie Frigilized Patn

Irtemediate Elameant Types

Ered Uzen
ATH Swkch

4 [+

Relationzhips

ATH Swikch - Intianetwaiking - IP Rowtes

SM5 - Intranebeorking - IF Bouter

Connechion Specs
Azzignable Bandvadith Link

[OK | Canen |

8. Click OK.
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9. Double-click Add Prioritized Path, and create the second prioritized path. The following figure

shows the completed Prioritized Paths view with two prioritized paths.

x|

# Managing a Template Conmection .
Connection spec Internet Connection from element type End User to elemeant type IP Router

General

Asgignable

Connection Spec

Prioritized Patie T T
Mewi Frigitizad Path 1 1
MNew Priaiitizad Path 2 2

10. Click OK.

PATH ANALYSIS

If a virtual connection has been set up with prioritized paths, you can manually design the connection

or use path analysis and let the application automatically design it. If you choose path analysis, the
system selects the path with the highest priority with available positions and displays it on the Path

Analysis Results window.

1. On the Service Request Connections window, double-click the virtual connection.

Service Request Connections

| Filew Edt- Views Options~ Window +

Statuz: [Al ]| Tope: [0 I— Category: |4l =

Identification Activity Status A Metwork Location

Type Category
Physical Bandwidth BROWHN, RvAN/ /ASSIGNABLE BANDWIDTH - Mew Installation  Fecord lssued
itusl [P |BROWMN, RYANS ANTERMET r:klj MMNECTIONN - New Installation [In Progress ]

2. Select Options>Design Mode from the menu at the top of the window.
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3. Select a design mode:
¢ Path Analysis by Hops

¢ Path Analysis by Distance

# Design Mode x|

Dezign kode
b anual Design 8
iPath Analysiz by Hops i+
Path fAnalysis by Distance f"[%

b &sirnum Mumber of Hops

o
o | o]

Tip
To limit the number of hops the designed connection can take, enter the maximum number in
the Maximum Number of Hops field.
4. Click OK.
5. Click the Schematic Design link.

The Path Analysis Results window displays the highest priority path found with available
positions.

® Path Analysis Results 7l
Select & path between the onginating &nd termingting slementz, Click Ok to conbnue, j‘
1Found 4 1-tcfl P

Paths Element Element Connection 1D Metwork Name
# hops 0.0 miles || End Usar ATH Syateh ERCAH, RYANT TASSIGNVABLE BEASDMAIDTH LINKJ 10030 Mere Natvaoek PR
ATH Sidch 1P Rewitiat CULUTH - SEMCIDULLTH - SWaCiFLD02E Nev Netwaork PR

The path anslysis search has been limited by 7 hops. The paths sre sorted by disbancs
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If there are multiple paths that are available between the components in the prioritized path, all will
appear on the window. In the example above, if the network contains multiple ATM Switches and
several paths exist between the End User — ATM Switch — IP Router, all of those would appear.

FAQ

If I have more than one prioritized path, how do I design using a path other than the highest
priority?

Answer: The application only displays the available path with the highest priority. If you want
to design using another path, simply design the connection manually.

Tip

You must change the design mode before clicking the Schematic Design link to initiate path
analysis.

Other related procedures

Attaching an image to a component type

1. On the Managing a Component Type window, click the Browse... link next to the Image Name
field.

_!'Hanaging a Component Type ilﬁl

General New Component Type

Customn Attributes NSRS

Element Types

» Companent Type M ame:
|
Image Mame:
] [Mone] | Browse._.

[V Active

[ Contiruous Add | ok I Cancel
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2. Click New on the Browse Graphic Images window.

Browse Graphic Images El

[ ezcription i Type |
IDS_HOUSE3DZ  code
IDS_ITEAR code
IDS_ITRIANGLE code
IDS_MTEXT code
IDS_OCTAGON code
IDS_P4PER code
IDS_PILLOW code
IDS_RECTANGLE  code 3
IDS_STEXT code .
ID5_TRIANGLE code L‘EI IDS_AGGREG
ID5_AGGRERG emf _ﬂ
IMC DI hre mremF
ok | Close

3. Locate your .emf file, and click Open.
Tip

Only .emf files can be used as images in MetaSolv Solution.

4. Select the .emf file in the left windowpane, click OK.

FAQ
If T want to use that image for a different component type, do I have to repeat this process?

Answer: No, once you have added the image to the database, it will be available in the
Image Name drop-down field on the Managing a Component Type window.

Tip

You can only delete user created .emf files that have not been associated with a component
type. You cannot delete preloaded .emf files.
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Creating a valid value for the Category field

1. Select the Application Setup group on the navigation bar, and click Valid Values.
2. Click Add New on the Valid Values Search window.

3. Complete the Valid Values Maintenance — New window.

#'valid ¥alues Maintenance 7| x|
Categan: | Connector Catenon =]
Walid % alue: Hew Conn Category
Y alue Description: |

System Function Code: |3
From Effective Date: 125772004 =

To Effective Date: | vl
Sustem Defined: I
Modifiable: =2

™| Cortinuous &dd | ok & I Cancel

4. Click OK.

CONNECTION TYPE — NEW WINDOW

This valid value will now appear in the Category field on the Connection Type — New window.

# Connection Type - New 2| x|

v Connection Type:

| =l
v Mame:

v Categony:

Adrmin Group -
Azzignable Group

Bandvadth 3
Facility

Mew Conn Categor
Product }E%
PwC | oK I Cancel
— Special il
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CONNECTION DESIGN SEARCH WINDOW

The New Conn Category checkbox will now appear for you to select when searching for a connection
that was created using a connection spec with this type of category.

File w Edit= View~ Options+ ‘Window -
Lirnit Murnber Found To: W
 Include Identification: |
[T Bandwidth Identification: |
[ Facility Connection Ref: |
[T Special MHetwark, Location: | |
[ Trunk Metwork Location: | |
[ Wirtual Dezignation: |
| Assignable Group Service Type: |[N0ne] =]
CRaenn B Skatus: |[N0ne] |
¥, Mew Cann Category Dedicated Te (Nane) = Facilities Must Have
% Cametilyy Im I_ | [Mone] =| Puositions
Fate Code: |[N0ne] x|
Bit Rate: | x|
Ckt Pos Remarks: |
Inventony
Ownership Code: |[N aneg] =
Ownership Bole: |[N ane) =]
Ownership TopeParticipant: |[N ane] =] | =]
Azzignment Control Code: I[N one) |
Azzignment Cantral Type/Participant: |[N|:une] A | |

it
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Modifying and maintaining
templates

This chapter explores some of the common tasks associated with modifying and maintaining network
templates. It provides suggestions for completing those tasks and insights on the effects of your
actions.

With the purchase of a technology module, you receive MetaSolv-created templates. While MetaSolv
worked to create templates with all the tools you need, there might be instances when you need to
make modifications.

Duplicating and creating reference templates

MetaSolv suggests that if you modify a delivered network template, you make a copy of the delivered
template for future reference. There are two methods of doing this—duplicate the template or create a
reference copy.
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DUPLICATE
Duplicating a template creates a copy of the selected network template. Any embedded templates are
reused in the new template, but copies of embedded templates are not made.

To duplicate a network template, right-click the template name and select Duplicate.

A pop-up message appears, notifying you that a new template was created and the name of that new
template. The name of the new template will be “Duplicate of,” followed by the name of the original
template. The new template will be listed under the technology module of the original template.

Tip

Once the duplicated template is listed in the panel list, you can change the name of the new
template. To do so, open the new template and change the Network Template Name field on
the Managing a Template window (Properties).

CREATE REFERENCE

Creating a reference template creates a copy of the selected network template as well as any
embedded templates. For example, if you create a reference for the MetaSolv TM ATM Access
Network template, you will have three new templates—ATM Access, IP Network, and PSTN.

To create a reference template, right-click the template name and select Create Reference.
A pop-up message appears, notifying you that new copies will be created of all embedded templates.
When you click Yes, a second pop-up message appears, notifying you that new templates were

created. The name of the new templates will be “Reference of,” followed by the name of the original
templates. The new templates will be listed under the technology modules of the original templates.

FAQ

Should I duplicate a template or create a reference?

Answer: It depends on what you’re trying to accomplish. Either method provides you the
ability to copy a template. However, if you create a reference template, new reference
embedded templates are also created.
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Changing template properties
ACCESSING TEMPLATE PROPERTIES
1. Open a template and right-click a blank area of the graphical canvas.

2. Select Properties.

METASOLV DELIVERED TEMPLATES

There are some limitations when changing the properties of MetaSolv delivered templates. On the
Managing a Template window, you are able to change all of the fields except the Template Type
field.

- Managing a Template ﬂ

General MetaSolv T ATM Access Network
Custom Attributes RS PRI i Grayed out and not
|ATHM_FR =1 > changeable.
v Metwork Template Mame:
tetaSale T AT Acc
v External/Internal: Available and
|Intermal Configuration of a Sustem =l changeable

[w Active

Ok I Cancel
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DUPLICATE, REFERENCE, AND USER CREATED TEMPLATES

The ability to change the Template Type field on the Managing a Template window varies depending
on the status of network systems built using the template. You can change the field if you have not yet
put a network system that was built using the template “In Service”.

x
General New Regional Template
Custom Attributes v Template Type: N
A T~
v Metwaork Template Mame:

[Mew Regional Template > Available and
changeable.

v Erternal/lnternal:
|Internal Configuration of a System |

[V Active

(] 4 I Cancel

After a network system has been created using the template and is placed “In Service”, you cannot
change the Template Type field.

® Managing a Template x|

General New Regional Template

Customn Attributes [P E N Ry Grayed out and not
|ATM_FR = 3 changeable.
v Metwork Template Marne:
MNew Reqgional Template
v External/ntermnal: Available and
| Irtermal Configuration of a Systemn =l changeable.
v Aclive

Ok I Cancel
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Adding component types

To add a component type to an existing network template, do the following:

1.

2.

6.

Open the network template.

Expand the Component Types panel list.

Left-click, hold, and drag the component type to the graphical canvas.

Right-click the added component type on the graphical canvas, and select Properties.
Complete the Managing a Component Type window.

Click OK.

Adding relationships

To add a relationship to an existing network template, do the following:

1.

2.

Open the network template.

Right-click one of the two component types between which you are creating a relationship, and
select Connect.

Drag the cursor to the second component type, and left-click.
Right-click the relationship just added, and select Properties.
Complete the General view of the Managing a Template Relationship window.

Click OK.
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Modifying a template embedded in another template

When a network template is embedded in another network template, you cannot expand the embedded
template and modify it. In the figure below, the New Regional Template is embedded in the New
Global Template.

MMy Desktop | Find Links | Show Navbar network Template - Mew Global Template

File » Edit= YWiew - Options =  Window «

4 =
B Metwork Templates —
E Component Types
B Connection Specs @
Metwork Template Detail Intrs
—_— “wiice Gateway IF Router
=. e Global Template s e Intra > Embedded network
=) Companent Types template
. [+ Mew Regional Template PSTN Intra
i e End User Location ﬁ OF P Network
[+ Relationzhips \"\-.._‘__ ATH Suitch /
Intra __— ~— Intra /

w Fegior =" Tplate
q Intra P

End User Location

If you want to modify the New Regional Template, you have to close the New Global Template and
open the New Regional Template, and then modify it.

¢ Deskiop | Find Links | Show Mavbar Network Template - New Regional Template

File » Edit-= Wiew =  Options «  SWindow -

| =
=) Metwork Templates
= Component Types /@
Connechion Specs \bice Gateway JF Rouers,
Metwaork. Template Detail Inirz Intra ‘@ Irtra

B I e Beagional Template

Intra
Component Types m

[+ Relationships Switch

AT Switch OF IP Metwork

Waming

If you expand an embedded template in another template, it might seem that you are able to
add relationships between component types. However, you are not adding relationships to the
embedded template, you are actually adding relationships to the larger template.
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Referring to the previous example, the New Regional Template is embedded in the New Global

Template.

| Find Lirks | Show Navbar network Template - Mew Global Template

File » Edit= YWiew - Options =  Window «
4 =
=5

Metwork, Templates

Component Types

Connection Specs

|

Metwork Template Detail

IS Mew Global Template
=B E_ompnnent Types

+- Mew Regional Template PSTN Intra
- End User Location ﬁ

Intra Intra

Intra
w Fegior =" Tplate
q Intra P

End User Location

With the New Regional Template expanded in the New Global T
relationship between the Voice Gateway and the IP Router.

Intr 1 IP Router
Shice Gateu.la\,r '_‘__.____htm
Intra
F 5TH
EIF IF Hetwork

AT Su.lrtch
H"“h-lrrtm —
Reglu:-n—"" Tiplate rrtm
Intra

/

End User Location

Intr&, s Gateway If Router Intra

[+ Relationzhips R . AT Swmi'l___ /

> Embedded network
template

OP 1P Metwork

emplate, you can create a
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You can associate a connection spec between the two component types. However, this added

relationship and connection spec are part of the New Global Template and not part of the New
Regional Template.

kop | Find Links | Shaw Mavbar nNetwork Template - New Regional Template

File » Edit» Wiew = Options =  ‘Window -

4 = No relationship

=7 Metwork Templates
=1 Component Types

Connection Specs

Adice Gateway P Router™,
Metwork Template Detai Intra Intra o Irtra
[=I Mew Reagional Template
[+~ Component Types
+- Relationships Suitch
= F AT Switch OF IP Metwork
PSTH

The relationship you created allows you to connect a Voice Gateway in one network created using the
New Regional Template to an IP Router in a separate network created using the New Regional

Template. It does not allow you to create a relationship between a Voice Gateway and an IP Router in
the same network.

Added
relationship

Mew Regional Template,
whice Gateway -
Irtranetworkin

OF [P Metwark

“Whice Gateway - |P Raouter -
witched Teh vMIeE - AT Switch - ATh Switch - Intranet
Intranetwarking - AThd Switch IR " -CIP F:-:-l.'::r WArHetwark
. Mew Regional Template, ."/ ]
PSTHN- AThd Switeh - Intranetwarking Switch - Intranetwe
i - - AT Switc:h
Metwark 1 AT Switeh - AThd Suwitch - e .
" _ w Metwork: 2
Metwork 1 End User LF'CET":"" - End User Location - er Location - w/
Iitranetwarking - New intranetworking - Mew yorking - Mew 5
Regional Te Regional Te zional Te

End User
Location
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Deleting network templates

MetaSolv recommends that you do not delete network templates unless absolutely necessary.
However, there may be instances when you choose to do so. The application performs validations to
determine whether a network template can be deleted. Following are descriptions of some of those
validations.

METASOLV-DELIVERED NETWORK TEMPLATES
You cannot delete any template that is delivered as part of a technology module. The delete option is
disabled for all preloaded templates.

TEMPLATES USED TO DESIGN A NETWORK SYSTEM

Once you use a network template to design a network system, the application will not allow you to
delete it. This is because the template contains the rules for not only network design, but also for
ordering and provisioning. If you attempt to delete a network template that has been used to design a
network system, you receive an error message.

TEMPLATES EMBEDDED IN ANOTHER TEMPLATE

You cannot delete a network template embedded in another template, until you delete the template in
which it’s embedded. If you try to delete it before deleting the other template, you receive an error
message.

Deleting component types

You cannot delete preloaded component types in MetaSolv Solution. Any user-created component
types can be deleted unless that component type has been added to an existing template.

1. Select the Component Types panel list.

2. Right-click the user-created component type you want to delete, and select Delete.
If the component type has been added to a network template, you receive an error message.

If the component type is not part of a network template and can be deleted, you receive a
confirmation message.

3. Click Yes.
Tip

If you cannot delete a user-created component type and are having difficulty locating it in
existing templates, try viewing the properties of the component type and looking at the
Element Types view of the Managing a Component Type window. This does not list the
templates specifically, but the element types listed there might give you some indication of
the templates you should look at for the existing component types.
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Deleting relationships

You can delete relationships from a network template, if they have not been used in a created network
system. If you try to delete a relationship that has been used in network design, you receive an error
message.

Before you can delete a relationship that is not tied to a network system, you must delete any
associated connection specs from the Connection Specs view of the Managing a Template
Relationship window.

Deleting connection specs

You cannot delete a connection spec that has been used in a relationship in a created network system.
If you try to delete the connection spec from the Managing a Template Relationship window, you
receive an error message.

Also, you cannot delete preloaded connection specs in MetaSolv Solution. User-created connection
specs can be deleted unless a connection spec is associated with a relationship in an existing template
or has been used in network system design. If you attempt to delete a user-created connection spec
and one of the two apply, you receive an error message.
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